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SUMMARY

Under certain conditions, Microsoft Exchange Public Folders may accidentally get re-homed to another site, resulting the loss of client permissions on the public folders. This may prevent users from being able to access the public folders, and prevent the original Administrators of the public folders from being able to administer these public folders.

This whitepaper explains the circumstances under which Microsoft Exchange public folders may get re-homed to another site, and why this results in the loss of client permissions.  It then details the steps required to recover from a situation in which public folders have been re-homed and the permissions have been lost. 

There are some proactive steps that an Exchange Administrator can take to quickly recover if the public folders do get re-homed. The whitepaper describes these steps and it describes some of the new features in Exchange Server 5.5, which can prevent public folders from getting re-homed. 
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Symptoms of Public Folder Re-homing

When looking at the properties of public folders, using the Microsoft Exchange Administrator program, some or all of the public folders in a Microsoft Exchange Organization have new Home Site and Home Server attributes.  The client permissions on the Public Folders have been lost.

Microsoft Exchange users may not be able to access public folders due lack of access rights on those folders. 

Administrators in the original home-site will no longer be able to modify the configuration of the public folders. This includes client permissions, replication schedule and storage limits. All changes to the configuration of the public folder will need to be done from the site where the public folder has been re-homed. However, if there are no replicas of the public folders in the site where they have been re-homed, it may not be possible to administer the public folders from this site as well.

When viewing the properties of the public folder from the Administrator program, connected to a server in the original site, most of settings appear grayed out. This is one reason why it may be important to re-home public folders to their original home site.

Mail messages sent to public folders are returned as undeliverable as the e-mail addresses of the public folders have been changed. This could be noticed when messages are automatically mailed to public folders, for example from a list server.

Why Public Folders get Re-Homed

There are three known causes for public folder re-homing and the associated loss of client permissions. 

1) Breaking a Directory Replication Connector between sites and then running the DS/IS consistency checker.

2) Running the DS/IS Checker on a server that has just joined an existing site.

3) Copying a PUB.EDB file from a recovery server to a production server, after DS/IS  consistency checker was run on the recovery server.

The DS/IS consistency checker is run after breaking a Directory Replication Connector

Assume a Microsoft Exchange Organization with two sites, SITE1 and SITE2. These two sites are connected by any one of the available connectors and they have a Directory Replication Connector between these two sites. 

Now the Directory Replication Connector between the two Microsoft Exchange Server sites is broken. After the Directory Replication Connector between SITE1 and SITE2 is broken, each site no longer has any knowledge of the other site. This includes any knowledge of the servers that are part of the other site and the mailboxes that are homed on servers in the other site.

At this stage, suppose the DS/IS Consistency Checker is run, say on a server (SERVER2) in SITE2. When the DS/IS checker is run, it checks the Directory entries for every public folder that is known in SITE2, which is all the public folders in the Organization. It verifies that the server name listed in the HOME-MDB directory attribute of each public folder is a server that it knows of. If it finds a server name that it is not aware of, it changes the value of the HOME-MDB attribute to be the name of the local server. Hence for all public folders, that are homed on servers in SITE1 (whose HOME-MDB attribute contain servers in SITE1), the HOME-MDB attribute is changed to be the local server name. 

In addition to checking the home server of each public folder, the DS/IS checker also verifies the permissions list associated with each public folder. If it finds any mailbox names that it cannot correlate to a name in the Global Address List (GAL), it removes that name from the permission’s list of the public folder. When you break the Directory Replication Connector between the two sites, all the mailboxes homed in SITE1 are removed from the GAL in SITE2. Hence when the DS/IS checker is run on the server is SITE2, it removes all mailboxes homed in SITE1, from the permissions list of all public folders.

So at this stage, the public folders in SITE2, may have lost their home server value as well as permissions information. Now if a Directory Replication Connector is recreated between SITE1 and SITE2, all information, including Directory and Public Folder information, is replicated between the two sites. When replication occurs, any objects present in SITE1 that have been modified in SITE2, are overwritten in SITE1, and vice versa. When the DS/IS checker was run in SITE2, it basically modified all the public folders. Unless the public folders were modified in SITE1 after the DS/IS checker was run in SITE2, all the 

changes made to the folders in SITE2, will be replicated over to SITE1. What this means is that all the public folders in the entire Organization will be homed on the server in SITE2 where the DS/IS checker was run as well as all public folder permissions given to mailboxes in SITE1 will be lost from the public folders.

This is the most common cause of public folders getting re-homed to a different site and server.

The DS/IS Checker is run on a server that has just joined an existing site

In certain situations it may be necessary to add a server to a Microsoft Exchange Site and then restore only the Information Store (IS) on this server to recover user mailboxes and public folders. Since the Directory Service (DS) data is not restored, the mailboxes need to be recreated in the DS by running the DS/IS consistency checker. However, if the DS/IS checker is run soon after the Setup program has completed, it may cause public folders to be re-homed and the loss of permissions.

At the end of the Setup program, the new server has started the process of replicating data from the other servers in the site. This process may be time consuming and hence it may take a while before the new server has information about the rest of the Organization. 

Suppose in the time before the new server has fully replicated all the data, the IS is restored on the new server and the DS/IS checker is run.  When the DS/IS checker is verifying the HOME-MDB attributes of the public folders it will not know that the server names listed in this attribute for the different public folders are valid server names as that information has not yet been replicated to this new server. Hence it will change the HOME-MDB attribute to be the name of the new server. Similarly, when checking the permission’s lists of the public folders, it may not find most of the mailboxes listed in the permissions lists as the GAL has not been fully replicated to the new server at that time. Hence, the DS/IS checker will remove all these mailboxes from the permission’s list of the public folders.

Gradually all the information about the rest of the Organization is replicated to the new server as well as information about the new server is replicated to the rest of the Organization. At this time, all the changes made to the public folders by the DS/IS checker on the new server will get replicated to the rest of the Organization since these changes are the most recent changes made to the public folders. This results in the public folders getting re-homed to the new server and the loss of client permissions associated with the public folders.

To prevent the DS/IS checker from modifying public folders, in version 5.5, changes have been made to allow the Administrator to control whether or not the DS/IS checker should re-home public folders and remove unknown user names from the public folders permissions lists. For more details on these and other enhancements in version 5.5, please refer to the section below, titled “Public Folder Enhancements in Microsoft Exchange Server, v5.5 “.

The PUB.EDB file is copied from a recovery server to a production server, after DS/IS consistency checker was run on the recovery server

During a disaster recovery situation, the public folders in an Exchange Server organization can get re-homed under the following circumstances:

1) The Information Store (IS) is restored to a recovery server.

2)  The DS/IS consistency checker is run on the recovery server.

3) The IS service is stopped on the recovery server.

4) The IS database files are copied to the production server and the IS service is started. 

When the IS service is started on the production server (after the pub.edb was copied from the recovery server), public folder replication will take place between the production server and the rest of the public folder servers in the organization. After replication has occurred, all unsecured public folders in the organization will get re-homed to the production server where the databases were restored. For more information on how to secure a public folder, please refer to the section below, titled “Public Folder Enhancements in Microsoft Exchange Server, v5.5 “.

After the public folders are re-homed, clients may not be able to access the public folders. Also, unlike the above two scenarios, in this case, no Administrators in any site will be able to administer the re-homed public folders. 

Why did the public folders get re-homed in this case?

The recovery server, on which the Information Store was restored, did not have a copy of the directory from the production server. Hence, when the DS/IS checker was run on this machine, the DS/IS checker did not have information about all the other servers and mailboxes in the organization. As a result, as explained the previous sections, the public folders were re-homed to the recovery server. In addition to re-homing the public folders, since a Directory object for the public folders was not found in the Directory on the recovery server, a new Directory object was created for each re-homed public folder. 

The following events should be logged on the recovery server on which the DS/IS consistency checker was run.

Event Type:
Information

Event Source:
MSExchangeIS Public

Event Category:
IS/DS Interactions 

Event ID:
7008

Date:

4/13/2000

Time:

10:13:15 AM

User:

N/A

Computer:
EXCHSRV01
Description:

Created a public folder OFFLINE ADDRESS BOOK\EX:/o=Company/ou=Site\OAB Version 2 in the directory service.

Event Type:
Information

Event Source:
MSExchangeIS Public

Event Category:
IS/DS Interactions 

Event ID:
7032

Date:

4/13/2000

Time:

10:13:15 AM

User:

N/A

Computer:
EXCHSRV01
Description:

The public information store /o=Company/ou=Site/cn=Configuration/cn=Servers/cn= EXCHSRV01/cn=Microsoft Public MDB became the home information store of folder OFFLINE ADDRESS BOOK\EX:/o=Company/ou=Site\OAB Version 2.

Event Type:
Information

Event Source:
MSExchangeIS Public

Event Category:
IS/DS Interactions 

Event ID:
7001

Date:

4/13/2000

Time:

10:13:15 AM

User:

N/A

Computer:
EXCHSRV01
Description:

The public folder Americas\Texas\Las Colinas in the directory service was updated with information store public folder properties.

Event Type:
Information

Event Source:
MSExchangeIS Public

Event Category:
IS/DS Interactions 

Event ID:
7021

Date:

4/13/2000

Time:

10:13:15 AM

User:

N/A

Computer:
EXCHSRV01
Description:

Users that were not valid have been removed from the access control list of public folder Americas\Texas\Las Colinas.

When the PUB.EDB from the recovery server was copied to the production server and the service started, the IS recognizes that the public store was restored from another server and it logs the following event saying the replication will not occur. This event is not accurate and replication does occur.

Event Type:
Information

Event Source:
MSExchangeIS

Event Category:
Recovery 

Event ID:
1117

Date:

4/13/2000

Time:

11:25:23 AM

User:

N/A

Computer:
EXCHSRV01

Description:

The public database has been restored to an alternate server.  This database will no longer be able to replicate with other public databases.

After the IS service is started on the production server, public folder replication starts occurring and since the public folders on this server have been modified more recently than those in the other sites/servers, the changes are replicated out to the other servers. 

When the Information Store on a server in another site receives the changes indicating that the folders that were previously homed on it are now homed in another site, the IS removes the Directory object for that public folder from the Directory as it assumes that the Directory in the new home site will contain the DS object for the public folder. This Directory change gets replicated to all the servers in the organization. Eventually, all the public folder and directory changes get replicated through out the organization. After this is complete, the public folders will appear to be homed in the site where the public store was restored, and the re-homed public folders will not have a corresponding directory object.

Because there is no associated directory object, when you try to get the properties of a re-homed public folder, the following error will be displayed in the Exchange Administrator program.
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Steps to Recover Re-Homed Public Folders

Determining which Public Folders have been re-homed

Before proceeding to recover the re-homed public folders, it may be useful to get an idea of which public folders have been re-homed and to what server they have been re-homed.

Bring up the properties of a public folder, using the Microsoft Exchange Administrator program. On the General Page of the folder properties, the Home Server and Home Site should be specified at the bottom of the page. 

In most cases it will not be possible to bring up the properties of the public folder. In this case, bring up the properties of the public information store on any server. Go to the Instances page. Select the Sites list. Now using up and down arrow keys, scroll through the different sites listed in the Sites list. When folders are re-homed, the folders will appear on the Instances page in the left hand list for the site to which they have been re-homed, instead of the original home site. Hence, scroll through the sites list till you find a site where all the re-homed folders are listed in the left hand list.

The server on which the DS/IS consistency checker was run will have event log entries indicating that the DS/IS checker was run. Check the Microsoft Windows NT Application Log for the following entry:

Event ID: 
7032

Source: 
MSExchangeIS Public

Type: 
Information

Category: 
IS/DS Interactions

Description:

The public Information Store /O=ORG_NAME/OU=SITE_NAME/CN=CONFIGURATION/CN=SERVERS/CN=EXCH_SRV01/CN=MICROSOFT PUBLIC MDB became the home Information Store of folder PF 3. 

For each public folder re-homed, there should be one of the above entries in the Application Log. This entry describes the public folder that was re-homed as well as the server that the folder was re-homed to.

In the above case, public folder “PF 3” was re-homed to server, EXCH_SRV01.

Determining if the Directory Objects for the Public Folders have been lost

As explained in the above section, under certain circumstances, it is possible that the directory objects for re-homed public folders will be lost.

Hence, it is important to determine whether the site in which the folders have been re-homed, have the directory objects for the re-homed public folders. 

By default, the directory objects for public folders are generated in the Recipients container. This container could be changed from the General page of the Information Store Site Configuration object. Using the Administrator program, click on the public folder recipient’s container and from the View menu select Public Folders and Hidden Recipients.  You should see the directory objects for all public folders homed in the current site. If you do not see the objects in this container, and you get the  “The object could not be found in the directory” error when trying to get the properties of the public folder from the public folder hierarchy at the top the Administrator program left hand pane, then the directory objects for the public folders are missing.

Automatically re-homing all folders back to their original servers

With Microsoft Exchange Server 5.5, Service Pack 4, it is possible to re-home all folders back to their original servers, automatically, using the information from a backup of the Information Store from before the re-homing occurred.

Previously, the re-homing process was manual to a large extent, and it was not possible to use backups of the Information Store. The manual process is outlined in the section titled “Manually Re-Homing the folders back to the original server”

The outline for the procedure to re-home the folders back to their original servers is:

a) Restore the Public Information Store from backup

b) Perform an Authoritative Restore on this data we just restored, to make this data the most current in the organization.

c) Allow these new changes to replicate throughout the organization.

Note:

This procedure involves running a debug build of the Information Store (STORE.EXE). This debug build should not be sent to customers. Hence, only Microsoft employees on-site at the customer location should perform this procedure. After the procedure has been completed, the debug version of STORE.EXE must be deleted off the customer’s machine.

The procedure below will result in a lot of public folder replication traffic, as we will need to replicate the entire public folder hierarchy to every public folder server in the Exchange organization. Hence, it is highly recommended that this procedure should only be performed after the MTA queues on public folder servers as well as bridgehead servers are clear. Otherwise, the MTA queues will get more backlogged. 

The steps required for re-homing the public folders to their original servers are as follows:

1) Select one server in the Exchange Organization that has a public Information Store, but does not have a lot of public folders replicated to it. Ideally this server will only have the public folder hierarchy. We should be confident that the hierarchy on this server was correct, before the re-homing occurred. 

The reason we would like a server with no public folder replicas is firstly the restore process will be faster, but more importantly, since we need to restore the Public Store from before the re-homing occurred, there could be some data loss as we will not be restoring any other backup sets or replaying any logs that might exist on the system, because we do not want the re-homing changes to be replayed into the restored database. 

2) Once you have selected a desirable server, stop the Information Store service on this machine.

3) Stop the Message Transfer Agent (MTA) and disable the service for now.

4) Rename the EXCHSRVR\MDBDATA directories on all drives of this machine. 

5) Create new MDBDATA directories on all drives.

We have just removed all existing data from the mdbdata directories to prevent any log files from being replayed when we restore from backup.

6) Restore the Information Store from backup. This backup should have been made before the re-homing occurred. 

7) Start the Information Store service. 

8) Once the service has started, stop it immediately.

9) Make sure that this server is running Microsoft Exchange 5.5 Service Pack 4. If this server is not at this version, you will need to upgrade the server to Version 5.5 Service Pack 4, at this stage. At a minimum, the server must be at Version 5.5 Service Pack 3, with a post SP3 hotfix build 2652.24 or later of the Information Store. If you decide to apply this store hotfix, the server must be upgraded to Service Pack 3, before the hotfix can be applied.

We need the IS to be on this build, because the Authoritative Restore process was added in build 2652.24 of the Debug build of the Information Store. 

Important:

Make sure that the Debug version of the IS is the same version as the release version on your system. Otherwise, it is possible that after running the debug build, the IS will not start when you revert back to the release build.

10) If you have upgraded the server to Exchange Server 5.5 Service Pack 4, stop the IS soon after it starts. 

11) Go to the EXCHSRVR\BIN directory and rename the STORE.EXE file to STORESP4.EXE.

12) Copy the debug version of the STORE.EXE to the EXCHSRVR\BIN directory.

13) At a command prompt, change to the EXCHSRVR\BIN directory.

14) Enter the following command:

STORE –a

15) You should now see a window titled “Server ITP”.

16) From the Debug menu, select the “Trace Info” option. This should bring up a dialog box.

17) In the listbox, select item 1, and then click on the “Enabled”, “Disk” and “Com1” options.

18) Close the dialog.

19) From the File menu, select “Start Public Store”.

20) From the Store menu, select “Do authoritative restore”. 

21) When prompted whether you want to perform this operation, enter the character ‘y’ (without the quotes) and the click OK.

22) When prompted to fix IPM folders type in ‘y’ (without the quotes) and click OK

23) You should now see messages displayed in the main window indicating that folders are being processed. Finally you should see a message indicating the total number of folders processed and that the process was complete. Following is an example of what you should see.

TAG 0:  Ulong time is 641333828

TAG 0:  Processed 100 folders

TAG 0:  Processed 200 folders

TAG 0:  Processed 300 folders

TAG 0:  Processed 400 folders

TAG 0:  Processed 500 folders

TAG 0:  Processed 600 folders

TAG 0:  Processed 700 folders

TAG 0:  Processed 800 folders

TAG 0:  Processed 900 folders

TAG 0:  Processed 1000 folders

TAG 0:  AuthRest complete!

TAG 0:  Processed 1049 folders

This is a fairly quick process but depending on the number of folders in the public folder hierarchy, it could still take several hours. A rough rule of thumb for the time required is around 75,000-100,000 folders per hour.

24) Once the IPM folders have been processed, if you need to re-home System Folders (Schedule+ Free/Busy, Offline Address etc.), from the Store menu, select “Do authoritative restore”. 

25) When prompted whether you want to perform this operation, enter the character ‘y’ (without the quotes) and the click OK.

26) When prompted to fix IPM folders type in ‘n’ (without the quotes) and click OK. The program should now update the system folders.

27) At this point, the updating process has been completed. From the File menu, select Exit, to terminate the debug store.

28) Delete the STORE.EXE file in the EXCHSRVR\BIN directory.

29) Rename STORESP4.EXE to STORE.EXE

30) Start the Information Store service. 

31) Enable the MTA and start the service.

32) Give the Information Store sufficient time to replicate the changes.

What we have done is gone in and updated each folder in the hierarchy with the current time stamp, in essence making that folder appear as the most recently updated. As a result, once the IS service is started, it will start replicating the updated hierarchy to all the other servers in the organization. This should restore the replica, home server and permissions information for all the public folders.

Once public folder replication has completed, the folders should no longer be re-homed and should appear back on the servers where they were originally. At this stage, the Administrator should be able to get properties of the folders. The above process should have restored all the public folder permissions as well. 

If when trying to get properties of public folders form the Administrator program, you get the error that the object could not be found in the directory, the directory object for the public folder was not found. This can be fixed by running the DS/IS consistency checker in the site where the public folders (that you cannot get properties for) should be homed. After DS/IS has been run, a directory object will be generated and you should be able to get properties for these mailboxes.

Note:

In order to avoid another public folder re-homing at this stage, before running the DS/IS checker, make sure that no Directory Replication Connectors have been broken.

If folders in multiple sites were re-homed, you may need to run the DS/IS checker in each of these sites.

The public folder Authoritative Restore cannot be used to recover deleted folders. In other words, if a large number of folders have been deleted by mistake, you cannot recover these folders by restoring from backup and running the Authoritative Restore.

If you needed to run the DS/IS checker to recreate directory objects for the re-homed public folder objects, you may need to modify the SMTP address for any public folders that are part of a workflow application. This is because the SMTP address of the public folders might have changed when the new directory object was generated.

You can automate the process of changing the email addresses of the public folders, using a tool called DSEXPORT.EXE. This tool can be got from Microsoft PSS.

The following KB article has more details:

XADM: How To Export Public Folder Directory Data To A CSV File

ID: Q185018

When importing the data using DSEXPORT, make sure you have the Obj-Container header field in your import file.

Manually re-homing the folders back to the original server

Microsoft Exchange Server, v5.5, has some new features that facilitate re-homing of public folders. Hence depending on whether a Microsoft Exchange Server, v5.5, is available or not, the procedure to re-home public folders back to their original locations will be different.

Following is a discussion of the procedures to re-home public folders back to their original servers when:

1) A version 5.5 server is available in the site

2) A version 5.5 server is not available.

A Microsoft Exchange 5.5 Server is available in the original site 

As mentioned above, Microsoft Exchange 5.5 has a number of new features designed to help with public folder re-homing situations. The Microsoft Exchange 5.5 Administrator program can re-home individual public folders to any server that contains a replica of the public folder. All sub-folders of the public folder can then be automatically re-homed as well. 

In order to re-home public folders using the Administrator program, you must be running the Exchange 5.5 Administrator program against an Exchange 5.5 server. Also, this procedure assumes that you want the entire public folder sub-tree re-homed to the Exchange 5.5 server.

The steps below assume that all the public folders were initially homed in site, ORIGINAL_SITE, and have been accidentally re-homed to site, NEW_SITE. The name of the Exchange 5.5 server in ORIGINAL_SITE is SRVPF55.  All folders under a folder called “NorthAmerica” need to be re-homed back to ORIGINAL_SITE and we don’t mind having a replica of these folders on server SRVPF55.

1) If an Exchange 5.5 server does not exist in site ORIGINAL_SITE add a new 5.5 server to the site, or upgrade an existing Exchange 4.0 or 5.0 server to version 5.5. Assume this 5.5 server is called SRVPF55.

2) Run the version 5.5, Microsoft Exchange Administrator program, against server SRVPF55.

3) Get properties of the Public Information Store object. The Public Information Store object is found under <Site>\Configurations\Servers\<Server Name>

4) Go to the Instances property page of the Public Information Store properties.

5) Search for the “NorthAmerica” folder in the list labeled “Public Folders”. You may need to select the site, NEW_SITE, in the “Site” list. Use the Folder path to make sure that you have found the correct public folder.

6) Once you have found the “NorthAmerica” folder, select it and click on the Add button. This will move the folder to the list labeled “Folders on this Information Store”.

7) Click on OK, to close the property sheet.

8) Press the F5 key to refresh the Administrator program.

9) In the Administrator program, under the organization object, click on the Folders object to expand it. Then click on the “Public Folders” object to expand it. You should now see the Public Folder hierarchy. Traverse the hierarchy till you reach the “NorthAmerica” folder. The path determined in Step 5, may be useful in traversing the hierarchy.

10) Select the “NorthAmerica” folder and from the File menu, select Properties. This will bring up the properties of the folder.

11) Go to the Advanced property page of the folder properties, as shown in the following figure.
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Advanced Page – Public Folder Properties

12) From the “Home server” list, select SRVPF55.  

13) Click on OK to close the property sheet. This will re-home the “NorthAmerica” folder to the server, SRVPF55.

14) Wait for about a minute.

15) Hit F5 in the Administrator program, to refresh the data displayed.

16) In the public folder hierarchy, select the “NorthAmerica” folder and from the File menu, select Properties, to bring up the properties of the folder.

17) Go to the Replicas page of the folder properties.

18) Check the list labeled “Replicate folders to”.  This list should have SRVPF55 in it. Remove from this list any servers that you do not all the subfolders of the “NorthAmerica” folder replicated to.

19) Once you have verified the replica list, go to the General page of the folder properties.

20) Select the setting labeled “Propagate these properties to all subfolders”. If this setting is not visible, you are either not using an Exchange 5.5 Administrator program or the folder whose properties you have obtained, does not have any sub-folders.

21) Click on the OK button. This will bring up a dialog titled “Subfolder Properties”. Unselect all options except Replicas. 

22) After selecting only the Replicas setting, click on OK. This will now start a process to automatically modify the replica list of all subfolders of the “NorthAmerica” folder, with the replica list of the “NorthAmerica” folder. This will result in a replica of all subfolders being added to the SRVPF55 server. This process may take a long time, up to several hours, depending on the number of subfolders. Once this process is completed, all the data in the public folders whose replicas were added, will start getting replicated to SRVPF55 server. This is an important if the only other replicas of the public folders are on servers across slow links and may cause very high network utilization on these slow links.

23) Refresh the Administrator program, by hitting the F5 key.

24) Get permissions of the “NorthAmerica” folder again.

25) On the General page, select the setting labeled “Propagate these properties to all subfolders”. 

26) Click on the OK button. This will bring up a dialog titled “Subfolder Properties”. Unselect all options except “Home Server”. 

27) Click on OK.

28) This will start a process to re-home all the subfolders of the “NorthAmerica” folder to the SRVPF55 server. 

Once this process has completed, all the subfolders will be re-homed to server SRVPF55. At this stage the public folder permissions will not be restored.

Also, as mentioned above, please note that the contents of all the subfolders will be replicated to the server SRVPF55. This may affect network utilization. 

Advantages of using an Exchange 5.5 server to re-home folders

Using the Exchange 5.5 Administrator program, in conjunction with an Exchange 5.5 server has the following advantages over other methods to re-home public folders.

a) The amount of work needed to re-home entire public folder trees is greatly reduced.

b) All the work is done on the original site and there is no need to access the server on which the folders were accidentally re-homed. This may be useful if the server where the folders are re-homed, is across a slow WAN link.

c) There is no need to add replicas of all folders to the server where the folders are re-homed. This eliminates the replication of the contents of all the public folders across a possibly slow network link.

Looking at the above advantages, even if an Exchange 5.5 server is not currently available in the original site, it may be useful to install an Exchange 5.5 server into the site to easily re-home the public folders back.

Note:

Once you install a 5.5 server into an Exchange site, it modifies the Directory schema in addition to making several other changes. You cannot add this server, re-home the public folders and then remove this 5.5 server from the site, unless there is another 5.5 server in this site. Also, please note that you will need to take additional steps, to add new version 4.0 servers into the site. 

No Microsoft Exchange 5.5 Server is available

If an Exchange 5.5 server is not available in the site in which the folder need to be re-homed back, and it is not possible to add a new server or upgrade an existing server, the PFADMIN.EXE program can be used to re-home the public folders. PFADMIN.EXE is a program that ships in the BackOffice Resource Kit and is available on the Microsoft Web site (www.microsoft.com).

Let’s assume that all public folders have been re-homed to a server, NEWSERVER, in site NEW_SITE. Assume that the folders were originally homed on OLDSERVER in ORIGINAL_SITE.

To recover from this situation, follow the steps below:

1) Determine against which server the DS/IS consistency checker was run which caused the public folders to get re-homed. In our example, this server will be NEWSERVER.

2) Look at the Application Log on NEWSERVER, searching for Event ID 7032. This will help us determine which public folders were re-homed, to NEWSERVER.

For example:

Event ID: 7032

Source: MSExchangeISPublic

Type: Information

Category: Public IS/DS

Description

The public Information Store /o=Organization/ou=NEWSITE/cn=Configuration/cn=Servers/cn=NEWSERVER/cn=Microsoft Public MDB became the home Information Store of folder Northamerica.

The above event indicates that the folder “Northamerica” was re-homed to server, NEWSERVER.

3) Run the Microsoft Exchange Administrator program against server, NEWSERVER.

4) Get properties on the Public Information Store object. This object is present under <Site>\Configuration\Servers\<Server Name>

5) Select the Instances page of the Public Information Store properties.

6) The public folders that were re-homed to this server will be listed in the list labeled “Public Folders”, if there was not a replica of the public folder on this server, before the re-homing occurred. If a replica previously existed on this server, the folders will be listed in the list labeled “Folders on this Information Store”.

7) In order to modify the properties of folders (change the home site, permissions, etc) a local replica of the public folders must exist on server, NEWSERVER. You can add replicas of the public folders listed in the list “Public folders”, by selecting all the desired folders and clicking on the “Add” button. This will move all the selected folders from the “Public folders” list to the “Folders on this Information Store” list. 

When a replica of a public folder is added to server NEWSERVER, this will cause that public folder to get replicated to NEWSERVER. Hence it is important to take into account the size of the public folder as well as the network links, before replicating a large number of public folders to NEWSERVER. 

8) On the Exchange server or another server or workstation, install the PFADMIN.EXE program from the BackOffice CD, by copying the files, PFADMIN.EXE and ACLCLS.DLL, to the local hard drive.

9) Install the Exchange client or Outlook, on the machine used in the previous step.

10) Create a MAPI profile called “PFProfile”. Add the Exchange Server Service to the profile. Enter NEWSERVER as the server name and a mailbox (say, TestMailbox) that exists on NEWSERVER.

11) Make sure that the Primary Windows NT account associated with mailbox, TestMailbox, has Service Account Admin privilege on the Exchange Organization, Site and Configuration containers.

12) To re-home the public folders back to OLDSERVER the following command will have to be run. 

PFADMIN  PFProfile  SetReplicas  “<Top Level Folder>” Replace OLDSITE\OLDSERVER Yes

Where <Top Level Folder> is the full path to a folder with sub folders all of which need to be re-homed back to OLDSITE\OLDSERVER.

The console will display a message as each public folder is re-homed. 

If subfolders should not be re-homed, the following command should be used: 

PFADMIN PFProfile SetReplicas  “<Top Level Folder>” Replace OLDSITE\OLDSERVER No

Note the if subfolders are not automatically re-homed, the above command will need to be executed for each subfolder.

Note:

The above commands to re-home the public folders, will remove all servers from the replica list of the public folders and only add the server specified on the command line. This will result in the loss of replica information. Hence after the above PFADMIN commands are executed, OLDSITE\OLDSERVER will be the only server in the replica list for all the public folders re-homed.

13) Once the PFADMIN commands have been run, the changes made on NEWSERVER need to be replicated over to OLDSERVER. Depending on the time it takes for these public folder replication messages to be delivered to OLDSERVER, you may need to wait a while. Make sure that normal mail messages can be delivered from NEWSERVER to OLDSERVER, otherwise public folder replication will not take place.

14) Verify that no Directory Replication Connectors are broken and then run the DS/IS Consistency Adjustment (Advanced page of the server object properties) on OLDSERVER. Once the DS/IS Consistency has been run the public folders modified by PFADMIN in step 12, will be re-homed back to OLDSERVER. The Application Log on OLDSERVER should contain the event 7032 entries for every folder re-homed.

At this stage the public folders will be re-homed back to OLDSITE. However the permissions as well as replica lists are will not be restored to what they were before the problem occurred. Also, if you have re-homed public folders to OLDSERVER that do not have a replica on OLDSERVER, you will need to add a replica using the Instances page of the Public Information Store properties.

Recovering Public Folder Permissions

After the public folders have been re-homed, using the steps in the above sections, the permissions lost during the original re-homing process will not be restored.  There are two methods of restoring public folder permissions:

1) Extracting the permissions from a backup and then automatically importing these permissions

2) Manually changing the public folder permissions, using the Exchange Administrator program.

These two methods are discussed below.

Automatically extracting Public Folder permissions and importing them 

In order to be able to extract the public folder permissions, a backup of the Directory and Information Store is required, from a time before the re-homing of the public folders occurred. The permissions are saved in the public information store for each folder that has a replica in that information store. Hence, from a particular backup, it will be possible to only extract permissions for those folders that have replicas in the public information store saved in the backup. Therefore it is a good idea to use a backup of a public folder server or any other server that had replicas of most of the public folders. 

The public folder permissions are saved in the public Information Store, but in order to extract these permissions, both the Microsoft Exchange Directory and Information Store will need to be restored on a recovery machine.

Since the Microsoft Exchange Directory depends on the NETBIOS machine name as well as the Exchange service account, you will need to perform the following steps on a machine on an isolated network, that is not connected to the production network.

Steps to configure a recovery server to extract public folder permissions

1) In the production domain where the Exchange service account resides, install a computer as a backup domain controller (BDC) with the same version of Microsoft Windows NT Server and service pack level as the production Exchange Server computer.

2) Make sure that the recovery server computer has enough free disk space and any other devices that are necessary, such as a tape drive or CD-ROM drive. Take this computer offline by isolating it from the production network on a hub.

3)  Promote this server to a primary domain controller (PDC) and reboot the computer.

4)  In the Windows NT Server Manager for Domains, add a BDC with the same Windows NT computer name as the Exchange Server computer, and rename the recovery server to the original Exchange Server computer name. (Verify that you are not on the production network first.)

5)  For more information, please see the following Microsoft Knowledge Base article:

        ARTICLE-ID: Q150298

        TITLE: Renaming a Windows NT PDC or BDC

6) Reboot the server. Now the recovery server should be running the same version of Windows NT Server as the production Exchange Server computer.

7) Install Microsoft Exchange Server as a new site, but use the same organization and site name as the production Exchange environment. Make sure to select the same service account as the production domain to use for the Exchange services.

8)  Update to the same service pack level as the production Exchange Server computer.

9)  Restore from backup the previous Microsoft Exchange Directory and the Microsoft Exchange Information Store.

Extracting Public Folder permissions using PFADMIN.EXE

PFADMIN.EXE is a program that ships with the BackOffice Resource Kit, Second Edition. This program allows an Exchange Administrator to export and import public folder permissions.  

To extract public folder permissions, follow the steps below:

1) On the Exchange server or another server or workstation, install the PFADMIN.EXE program from the BackOffice CD, by copying the files, PFADMIN.EXE and ACLCLS.DLL, to the local hard drive.

2) Install the Exchange client or Outlook, on the machine used in the previous step.

3) If no mailboxes exist on the server that we restored from backup, you will have to create a mailbox. While created the new mailbox, you may get an error from the Exchange Administrator program indicating that the directory is busy replicating. In this case, please refer to the following KB article:

ARTICLE-ID: Q160850

TITLE: XADM: DS_E_BUSY After Directory Service Restore        

4) Create a MAPI profile called “PFProfile”. Add the Exchange Server Service to the profile. Enter the server name and a mailbox (say, TestMailbox) that exists on the server specified.

5) Make sure that the Primary Windows NT account associated with mailbox, TestMailbox, has Service Account Admin privilege on the Exchange Organization, Site and Configuration containers.

6) Run the following command from a Windows NT command prompt:

PFADMIN  PFProfile  LISTACL  ALL   O=FILE.CSV

Where:

PFProfile is the profile that was created in step 4.

FILE.CSV is the name of a file that will contain the commands to restore the public folder permissions.

The above command will extract the permissions for all public folders whose replicas are available in the Public Information Store. If you wish to extract the permissions for only a certain public folder hierarchy execute the following command.

PFADMIN  PFProfile  LISTACL  <Top level folder name>   O=FILE.CSV

Where: 

<Top level folder name> is the full path to the folder from where the program will start extracting permissions. For example this folder name could be “WorldWide Data\Northamerica\Texas”.  If the path contains spaces you will need to enclose the name in double quotes.

Note:

Make sure that you are using version 1.3.0 of PFADMIN.EXE.

Extracting Public Folder permissions using PFINFO.EXE

PFINFO.EXE is a program that allows a Microsoft Exchange Administrator to extract useful information about Exchange public folders, including public folder permissions. 

This program is currently not available in the BackOffice Resource Kit, but can be obtained from Microsoft PSS.

Like, PFADMIN, this program can also extract public folder permissions into a text file which can then be used to automatically import public folder permissions.

Please refer to the section below on using PFINFO.EXE, titled “Proactively running PFINFO.EXE to extract Public Folder Information”.

Importing Public Folder permissions into the production Exchange system

Assuming that you have used either PFINFO.EXE or PFADMIN.EXE to extract the public folder permissions, you can follow the steps below to import these permissions into the Microsoft Exchange public folders.

1) On the Exchange server or another server or workstation, install the PFADMIN.EXE program from the BackOffice CD, by copying the files, PFADMIN.EXE and ACLCLS.DLL, to the local hard drive.

2) Install the Exchange client or Outlook, on the machine used in the previous step.

3) Create a MAPI profile called “PFProfile”. Add the Exchange Server Service to the profile. Enter OLDSERVER as the server name and a mailbox (say, TestMailbox) that exists on OLDSERVER. 

4) Make sure that the Primary Windows NT account associated with mailbox, TestMailbox, has Service Account Admin privilege on the Exchange Organization, Site and Configuration containers.

5) Run the following command:

PFADMIN  PFProfile  < PFAdminInputFile.txt

Where PFAdminInputFile.txt is the file containing the PFADMIN.EXE import commands. This is the file generated using the PFINFO.EXE program or the PFADMIN.EXE program. 

Note:

This data file should not be generated from the production Exchange system once the re-homing has taken place. Either you have this data file from before the problem occurred or follow the steps outlined in the previous section on extracting this data from a backup.

6) Once the above command has completed, the public folder permissions will be restored. This information should then automatically get replicated to all other servers in the organization that have replicas of the public folders. 

Manually modifying Public Folder permissions 

The Microsoft Exchange Administrator program (v5.0 and later) has the ability to recursively assign permissions to all public folders in a public folder hierarchy. This feature can be used to facilitate the assigning of permissions to a public folder hierarchy.

To assign permissions to all folders in a hierarchy, follow the steps below:

1) In the Microsoft Exchange Administrator program, expand the public folder hierarchy, and select the public folder whose subfolders need to have their permissions modified.

2) From the File menu, select properties to bring up the properties of the public folder as shown below.
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Public Folder Permissions – General Page

3) On the General page of the folder properties, click on the Client Permissions button. This will bring up the Client Permissions dialog. Modify the folder permissions as required and click on OK to close the dialog.

4) If the folder in question has subfolders and you are using the version 5.0 or later Administrator program, on the General page, there will be a setting called “Propagate these properties to all subfolders”. Select this option and click on OK. 

5) The Subfolder Properties dialog, shown below, will be displayed. Deselect all the options, except “Client permissions”. Click on OK.
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Subfolder Properties Dialog

6) The Administrator program will now automatically apply the client permissions of the current folder to all its subfolders.

Precautions

In order to easily recover from a situation in which public folder permission and replica information has been lost, it may be a good idea to proactively extract this information from the production Exchange site. This section discusses some of the options available to proactively save public folder information.

Proactively running PFADMIN.EXE to extract Public Folder permissions

Please refer to the section title Extracting Public Folder permissions using PFADMIN.EXE, for more information on how PFADMIN.EXE can be used to extract public folder permissions, from a production Exchange server site.

Proactively running PFINFO.EXE to extract Public Folder Information

The Microsoft Exchange Public Folder Information Program (PFINFO.EXE) is a program available from Microsoft PSS. It does not currently ship in the Microsoft BackOffice® Resource Kit. 

This program extracts information about the Public Folders in a Microsoft Exchange Site. This information is saved into a delimited file, which can be viewed in a spreadsheet like Microsoft Excel. The data can then be manipulated in any way desired.

The program can extract the following information to the delimited output file: 

· Public Folder Name

· Public Folder Path

· Public Folder Permissions

· List of Public Folder Replicas

· Number of Replicas of the Public Folder

· Number of Items in the Public Folder

· Size in Kilo Bytes of the contents of the folder, not including sub-folders

· Age Limit

· Replication Message Priority

· Replication Schedule

· Alias

· Storage Limit (K)

· Date the Public Folder was Created

· Date the Public Folder was last modified (As seen in the Exchange Administrator program)

· Home Site

· Home Server

· E-mail Addresses.

This information can be imported into a spreadsheet for further analysis. For example, it is possible to determine the largest public folders, or chart the most used public folders in terms of size. It is also possible to determine the location of public folder replicas and then looking at the public folder sizes, determine whether additional replicas are needed or not. The Home Server and Home Site information can be useful in case the public folders are accidentally re-homed to another site.

In addition to a delimited file containing the above information, PFINFO.EXE can generate another file that contains the commands to import public folder permissions and replica information. These commands are in a format that the utility, PFADMIN.EXE, can understand. The actual import of the permissions and replica information into the Exchange server(s) is done by PFADMIN.EXE.

Hence, by proactively running PFINFO.EXE in each site of a Microsoft Exchange Organization, it is possible to extract and save information on the permissions and replicas of all public folders in an Exchange Organization.  In case the public folders are re-homed and permissions are lost, recovering from this situation will be much easier using the import file created by PFINFO.EXE in conjunction with PFADMIN.EXE.

Both PFADMIN.EXE and PFINFO.EXE will extract information for all public folders that have replicas on a server in the current site, as well as those public folders whose only replicas are in sites with which the current site has public folder affinity. The main advantage to running PFINFO.EXE instead of PFADMIN.EXE is that PFINFO extracts additional information, which could be used by Microsoft Exchange Administrators.
Preparations

Before running PFINFO.EXE to extract public folder information, you should perform the following steps:

1) Install the Microsoft Exchange client or Microsoft Outlook on a Windows NT server or workstation. You can run this program on an Exchange Server machine.

2) Create a MAPI profile, connecting to a server in the site that you wish to extract public folder information. You can select any mailbox on the desired server, but it is recommended that you create a separate mailbox for use with PFINFO.EXE

3) Though not necessary, it is recommended that you log into Windows NT on the machine running PFINFO.EXE, using the Exchange Service Account.

Running PFINFO.EXE

To execute PFINFO, double click on PFINFO.EXE from the Windows Explorer. This will bring up the main window of the Microsoft Exchange Public Folder Information Program (PFINFO.EXE), shown below.
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PFINFO.EXE - Main Window

In the above figure, the Output Filename is the file into which the public folder information is written, using the delimiter specified. This is not file that can be used with PFADMIN.EXE, to import public folder permissions and replica data.

If the option “Only extract data for public folders homed in the current site” is selected, the program will to connect to public folders whose HOME-MDB attribute contains a site name different from the site against which you are running the program. This will speed up operation of the program, as otherwise the program may try to connect to servers in other sites with which public folder affinity is setup. 

To generate an import file that contains commands that can be used with PFADMIN.EXE to restore public folder information, select the option labeled “Create file for use with PFAdmin.exe”. This will enable the “Options” button. Click on this button to bring up the “PFAdmin Output File Options” dialog as shown below. 
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PFAdmin Output File Options Dialog

The filename specified in the PFAdmin Output File Options dialog is the file that will contain the commands that can be used as input to the PFADMIN.EXE program.

Note:

You must use a version of PFADMIN.EXE, version 1.3.0 or higher, in order to be able to successfully import the data from the file generated by PFINFO.EXE. This version of PFADMIN.EXE is available in the BackOffice Resource Kit, Second Edition.

Once you have configured the program to your needs, to start execution of the program, click on the “Start” button on the main window. This will bring up a dialog listing all the profiles available on the local machine, shown in below.
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Profile Selection Dialog

Select the desired profile and then click OK.  

The program will then extract all the public information into the two selected files. By default the PFADMIN commands will be saved in a file C:\PFADMDAT.TXT and the general public folder information will be saved in C:\PFINFO.TXT.

The file PFINFO.TXT can be opened up in a spreadsheet like Microsoft Excel and manipulated to extract the desired information. The file PFADMDAT.TXT is for use with the PFADMIN.EXE program.

To use this file with the PFADMIN.EXE program, the command line required is

PFADMIN <profile name>  < PFADMDAT.TXT

Where <profile name> is the name of a MAPI profile that the PFADMIN program can use.

For more information on PFADMIN.EXE, please read the documentation in the Microsoft BackOffice Resource Kit.

Automating the extraction of Public Folder Information, using PFINFO.EXE

The above section shows how to run PFINFO.EXE manually. It is also possible to run PFINFO.EXE in a batch process. This will allow the program to be run from a scheduler and hence it is possible to run the program every night to make a backup of the public folder permissions. This can be extremely useful in case of an emergency where all public folder permissions are lost, as explained above.

To extract public folder information in batch mode, you must be running PFINFO, Version 3.5 or later. With this release the capability to read configuration information from an INI file was added to the program. This allows the program to be run without any user intervention, using the Windows NT AT Scheduler.

Instead of using the Windows NT AT command to schedule a task from a command prompt, it is easier to use the WINAT.EXE program that provides the user with a GUI to schedule tasks. The WINAT.EXE program ships in the Microsoft Windows NT Server 4.0 Resource Kit.

Running PFINFO.EXE using WINAT.EXE

The steps below describe how to use WINAT.EXE  to run PFINFO.EXE automatically according to a schedule.

1) From the Services applet in the Window NT Control Panel, change the Startup properties of the Windows NT Schedule Service. Use the Exchange Service Account as the startup account. If the Schedule service is started using the Local System Account, PFINFO.EXE will fail with a MAPI Logon Error.

2) Start the Windows NT Schedule Service

3) Set the following settings in the PFINFO.INI file. This file should be in the same directory as the PFINFO.EXE file.

[PFINFO]

ProfileName=<Any Valid Profile>

Where <Any Valid Profile> is a profile containing the Exchange Server service. The Exchange Server service should be configured with a server in the site that you wish to extract public folder data from, as well as a mailbox on the server specified.

In addition to the above settings, you can also configure the names of the output files, log file and other settings using the .INI file. For more information on the INI file settings available, please refer to the section below.

4) Run WINAT.EXE

5) From the Edit menu, select Add. This will bring up the Add Command dialog as shown below
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WINAT.EXE  - Add Command dialog

6) In the Command edit box, enter 

<Path>\PFINFO –S

Where <Path> is the full path to the PFINFO.EXE file

The –S command line option specifies that the program will be executed from a service. 

If the –S option is specified, the program executes without displaying any user interface and does not wait for any user input. However, you must make sure that the ProfileName entry in the .INI file has a valid profile specified and that this profile is not configured for offline use. Otherwise the program will not be able to successfully perform a MAPI login and will fail. 

The –S option should be specified only when running PFINFO from the Windows NT Scheduler. When running PFINFO interactively (from a command prompt or Windows Explorer), the –S command line option should NOT be specified. When the –S command line option is specified, the program assumes that it is being called from a Service and initializes MAPI differently.

7) Configure when you wish the program to be executed.

8) Click on OK.

9) Exit WINAT

10) The Windows NT Scheduler will automatically execute PFINFO at the time specified and the output files will be generated in the locations specified in the PFINFO.INI file. Besides entry in the log file, there will be no indication that the program has completed execution.

Note:

The INI file with all the configuration information must be present in the same directory as the executable and must be called PFINFO.INI

PFINFO.INI Settings

; **********************************************************

;                 PFINFO.INI

; **********************************************************

; This file is for use with the Microsoft Exchange Public 

; Folder Information Program (PFINFO.EXE), v3.5 or higher

;

[PFINFO]   

; AutoRun
; If this value is set to 1, the program will execute without waiting for any user input.   This 

; setting,  if set to 1, will cause the program to display the normal GUI, but the program will 

; automatically start executing, without allowing the user to change any of  the settings. The 

; program will use the settings in this file or the default values.

; Once the  program has completed extracting the public folder data, it will exit without waiting for 

; further user input.

;

; Make sure that the profile specified is valid, or PFINFO will prompt for one.

; Also make sure that the profile selected is not configured for offline use. If it is, the program will 

; display a dialog, asking the user to select between online and offline use.

; Default Value = 0

;

AutoRun=0

; ProfileName
; Name of the profile to be used by the program to log into the Exchange server.

; This profile must already exist.

; Default Value is NULL

;

ProfileName=<PFINFO MAPI Profile>

; LogFileName
; Specifies the log file that PFINFO will append logging information to.

; Default Value = C:\PFINFO.LOG

;

LogFileName=C:\PFINFO.LOG

; LoggingLevel
; Set the level of logging:

; Possible Values:

; 0 - None

; 1 - Minimum

; 2 - Medium

; 3 - Maximum

;

; Default Value is 0

;

LoggingLevel=0

; OutputFileName
; Specifies the file that PFINFO will output Public Folder data to.

; If this file exists, it will be overwritten.

; Default Value = C:\PFINFO.TXT

;

OutputFileName=C:\PFINFO.TXT

; OutputFileDelimiter
; Specifies the delimiter used in the Output File.

; Possible values:

; 0 - Comma

; 1 - Tab

; 2 - Semi Colon

;

; Default Value = 1 (Tab)

;

OutputFileDelimiter=1

; OnlyExtractLocalSiteFolders
; If this value is set to 1, PFINFO will extract data only for public folders homed in the current 

; site. The current site is the site containing the Exchange server specified in the selected profile.

;

; Default Value = 0

;

OnlyExtractLocalSiteFolders=0

[PFADMIN]

; GeneratePFAdminFile
; If this value is set to 1, the program will generate a file containing data in a format that can be 

; input to PFADMIN.EXE.

; PFADMIN.EXE is a program that ships in the BackOffice Resource Kit.

; The version of PFADMIN.EXE used must be 1.3 or later. 

;

; Default Value = 1

;

GeneratePFAdminFile=1

; PFAdminInputFileName
; Name of the file to write the data for use with PFADMIN.EXE.

; If this file exists, it will be overwritten.

; Default Value is C:\PFADMDAT.TXT

;

PFAdminInputFileName=C:\PFADMDAT.TXT

; GetPermissions
; Controls whether or not public folder permissions data is written to the PFAdmin Input File.

; If the value is set to 1, the permissions data is written.

; If the value is set to 0, no permissions data is written.

; Default Value is 1

;

GetPermissions=1

; GetReplicas
; Control whether or not public folder replicas data is written to the PFAdmin Input File.

; If the value is set to 1, the replicas data is written.

; If the value is set to 0, no replicas data is written.

; Default Value is 0

;

GetReplicas=0

Troubleshooting PFINFO.EXE

To troubleshoot problems with PFINFO.EXE, the program supports 4 different logging levels: None, Minimum, Medium and Maximum. The logging level can be controlled either by setting the value of the LoggingLevel  setting in the PFINFO.INI file, or by using the –LogMin, -LogMed or –LogMax command line options.

Common Issues with PFINFO.EXE

MAPI Logon Error – MAPI_E_LOGON_FAILED

The log file shows the above error. This error can be caused by any of the following conditions:

1) Invalid or missing profile name in the PFINFO.INI file

2) Invalid or missing mailbox or server specified in the profile

3) The Windows NT account currently logged in, does not have access to the Exchange Server. It is recommended that you log in using the Exchange Service account.

4) The Windows NT account used to Startup the Windows NT Schedule service is invalid or does not have rights on the Exchange Server. It is recommended that you use the Exchange Service account.

Public Folder enhancements in Microsoft Exchange Server, v5.5

Microsoft Exchange Server, v5.5, has some new features that allows an Administrator to protect public folders from being re-homed to another site.  These features are describes in the sections below.

Securing Public Folders to a site

Each folder now has a new attribute, called the Secure Public Folder attribute, associated with it. This attribute controls whether or not this folder can be administered from a site other than the home site. The value of this attribute is controlled by the new “Limit administrative access to home site” property on the General page of a public folder’s properties.

The following figure shows the “Limit administrative access to home site” property. This setting is only available in the version 5.5 Administrator program.
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When this setting is selected, the current public folder cannot be re-homed to another site. If this option is selected only users with administrative permissions in the public folder’s home site who are connected to the home site can re-home the public folder and create public folder replicas. 

When a site is disconnected, the DS/IS consistency checker cannot reset the Home-MDB attribute to the server/site where DS/IS consistency checker is run or reset the permissions list.  

Since the DS/IS consistency checker may not be able to re-home public folders, any replicas of secure folders that cannot be re-homed, will be “orphaned”.  These “orphaned” replica instances of secured public folders will be automatically deleted without the deletion information ever being replicated to other sites.

This will prevent the folder from being accidentally re-homed to another site, by an Administrator running the DS/IS adjustment on a server in another site.

It is possible to automatically set this option on all sub-folders of a top-level public folder, by selecting the “Propagate these properties to all subfolders” option on the General page of the public folder properties and then clicking on OK. 

This should bring up the Subfolder Properties dialog. Select the “Limit administrative access to home site” option and click on OK. The Administrator program will now automatically modify each sub-folder of the current folder, with the desired setting.   

Note:

The “Limit administrative access to home site” setting is automatically set on all public folders that are created on an Exchange 5.5 server. This property is not set on folders created on a Exchange 4.0 or 5.0 server or on folders that were upgraded to version 5.5. In this case, the Administrator will need to make the required changes.

Because the Internet Newsgroups folder is not homed in any site, the Secure Public Folder property cannot be set on this particular top-level folder, but can be applied to its subfolders.

Site Folders (Schedule+ Free/Busy, Offline Address Book, Organization Forms) are not secured by default. You must manually get properties of these folders and set the “Limit administrative access to home site” attribute. Please refer to the following Microsoft Knowledge Base article for more information.

XADM: System Folders Are Not Secured To The Site By Default  

ID: Q177775
DS/IS Consistency Checker Enhancements

The Microsoft Exchange Administrator program, v5.5, has new options that give the administrator greater control over the DS/IS Consistency Adjustment process.

The following figure shows the new options available, which allows the administrator to prevent the DS/IS adjustment from re-homing public folders as well as modifying public folder permissions.
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Note:

Even though the above new features in Exchange 5.5 will help prevent public folders from getting re-homed accidentally, there is still a risk of re-homing occurring in mixed environments which contain version 4.0 and 5.0 Exchange Servers. 

This is because version 4.0 and 5.0 Exchange Servers do not recognize the Secure Public Folder property. Hence, it is still possible for a 4.0 or 5.0 administrator to re-home a public folder, even if it has been secured by an administrator of version 5.5 Exchange Server.
Therefore until all the servers in an organization are running Exchange Server, v5.5 or later, it is important to take the precautions outlined in this document to easily recover from a possible re-homing situation.
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